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We're always looking for good tips. Send us your favorite, and if we print it we'll send 

you an Adobe Magazine sweatshirt. Send your tips to Editor, Adobe Magazine, 411 

First Avenue South, Seattle, WA 98104-2871. Please include your name and phone 

number in case we need more information. 

PageMaker Q&A 

Q Whenever I try to draw a rectangle or oval in Page

aker, I get a perfect square or circle-what's the deal? 

A Normally, if you want to draw a perfect square or a per

fect circle, you use the rectangle or ellipse tool while hold-

g down the Shift key. If you're getting perfect squares and 

circles even when you don't have the Shift key held down, 

chances are your problem is being caused by an old driver 

dated 1 /11 /93 or earlier) for a Logitech three-button 

mouse. To fix it, update the Logitech driver to version 6.24 

or later. To do so, download the most current versions 

of MOUSE.COM and LMOUSE.DRV from the Logitech forum 

CompuServe (type GO LOGITECH) or from Logitech's BBS 

510-795-0408). 

PC Mac 

Q I keep hearing about PPDs. They sound pretty 

· portant, but I don't quite understand why. What 

exactly are they? 

A PPD (Postscript printer description) files are text-only 

"- es, written in the Postscript language, that describe the 

-nodel-specific characteristics of Postscript devices (print

;;,rs, imagesetters, and so forth). PageMaker and other appli

::ations that use PPDs rely on these files to give them the in

- rmation they need to print correctly and efficiently to 

::ostScript devices. 

When you print from PageMaker, you should select the 

right PPD file for your Postscript device from the "Type" 

pop-up menu in PageMaker's "Print document" dialog box. 

If you don't use the right PPD, chances are you won't be able 

to take advantage of all your printer's features, your jobs 

might print less quickly, and (in extreme cases) you could 

even receive Postscript errors. 

Here's a partial list of the model-specific features de

scribed in a PPD file and why PageMaker needs that infor-

mation when it prints: 

t How much free virtual memory 

your PostScript device has. The 

free virtual memory setting in 

a PPD reflects how much RAM 

your Postscript device has 

available to produce the ras

terized page descriptions of 

your files ("free virtual mem

ory," in this case, is actual RAM 

and has nothing to do with 

your printer's hard disk). Page

Maker uses this number to de

termine the most efficient way 

to download Postscript re

sources such as fonts. If you're 

using a PPD that says your 

printer has less free virtual 

micro tip 

Have a PPD that's not showing up in 

your "Type" pop-up menu? Perhaps the 

PPD file is in the wrong folder or 

directory. In Windows, make sure your 

PPD file is the ALDUS/USENGLSH/PPD4 

directory ( or whatever your PPD4 direc

tory is according to the "PPD4= ... " 

line in the [Aldus] section of your 

W IN.IN I file). On the Mac, make sure 

it's in the "Printer Descriptions" folder 

in your "Extensions" folder within the 

System Folder. 

memory than it really does have, PageMaker might 

download, flush, and redownload fonts more fre

quently than necessary, thereby needlessly increasing 

your print times. If your PPD file has a free virtual 
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Q&APageMaker 

memory setting that's too high, you could experi
ence Postscript errors. 

t What fonts are built into your PostScript device. Page
Maker uses the PPD's list of built-in fonts to deter
mine which fonts it must download. Using the right 
PPD with the right font list will ensure PageMaker 
can download the correct fonts for the fastest pos
sible output without font substitution. 

t Your PostScript device's paper options. PPD files in
clude information about what paper sizes and trays 
your Postscript device supports, and whether or 
not it offers custom paper sizes. Using the right PPD 

file ensures you can take advantage of all your 
Postscript device's paper features. 
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-Pages 
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D Print blank pages D Page independence 
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-sook .- Orientation - Reset 
D Print all publications in book 

lj[!s) D Use paper settings of each publication 

Each time you print, 

make sure you're using 

the right PPD file (one 

written for your printer 

model), or better yet, 

a custom printer file 

specially created for your 

individual printer. Select 

the PPD or custom 

printer file from the 

"Type" pop-up menu in 

PageMaker's "Print 

document" dialog box. 

PageMaker 5.0 ships whh dozens of PPD files-if you 
need to install one, just run the setup program "ALD
SETUP.EXE" or PMSSETUP.EXE (Windows) or "Aldus In
staller/Utility" (Macintosh) on the first PageMaker instal
lation diskette. If PageMaker didn't come with a PPD file 
for your Postscript device, there are several places you 
can obtain one. First, try Adobe's free BBS at (206) 623-
6984 and look in the "PPD files" folder in the "File Li
brary" section. If you don't have a modem, try the near
est Adobe Authorized Service Provider, who may down
load the file for you. If those options don't pan out, try 
going directly to your Postscript device's manufacturer, 
who can supply you with a PPD file or recommend one 
that's a close match. 

The information in PPD files reflects the model-spe
cific characteristics of your Postscript device as it was 

manufactured. However, if you've changed your 

Postscript device-by adding fonts, memory, or other 

features-your PPD won't accurately describe your de
vice anymore. If you want to take full advantage of the 

features you've added, you'll need to update the infor
mation about your printer. Fortunately, Adobe offers 
some utilities that make that easy. 

If you use the Windows version of PageMaker, you can 
get a utility called "Update PPD"-the current version is 
2.0 and it's available on Adobe's free BBS (call 206-623-
6984 and download the "UPPPD2.ZIP" file from the sec
tion File Library: PMS: PC: UpdatePPD V2) and on Adobe's 
forums on CompuServe and America Online (see pages 
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114-15 for information on those forums). It's also included in 
the PageMaker 5.0 Enhancement Pack for Windows, avail
able through Adobe Customer Services at (800) 628-2320 
for a shipping and handling charge of $9.95. 

If you use PageMaker 5.0 for the Macintosh, you can use 
the "Update PPD" Addition, which came with PageMaker. 
The most recent version of Update PPD is 1.7, and it's avail
able on Adobe's free BBS (download "UPdp17.sea" from the 
section File Library:PMS:MAC:UpdatePPD) and on Compu
Serve and America Online. It's also in the Macintosh Page
Maker 5.0 Enhancement Pack (see the previous paragraph 
for ordering information). 

Both the Windows and Macintosh "Update PPD" utilities 
create a custom printer file, which is a special kind of PPD file 

that appends or overrides the information in the original 

PPD file. After creating a custom printer file with one of 
these utilities, be sure to use it when you print-select the 
new file instead of your original PPD from the "Type" pop
up menu in the "Print document" dialog box . 

If you want to learn more about PPDs and custom printer 
files, the following FaxYI documents can help: 
t 215120-Creating custom printer files: Comprehen

sive overview 
t 100101-Adding custom paper sizes to a custom 

printer file using a text editor 
t 100102-Updating PPD files to reflect available virtual 

memory using a text editor 
t 100103-Adding fonts to a custom printer file using a 

text editor. 

PC Mac 

Q My office recently installed Adobe Acrobat Pro, and 

now we want to be able to create PDF files from our 

PageMaker publications. What's the best way? 

A If you installed the "Pro" version of Adobe Acrobat, you 
have all four of the major components of Acrobat: the Acro
bat Reader, the PDFWriter, Acrobat Exchange, and Acrobat 
Distiller. With these tools you have two options for creating 
PDF (Portable Document Format) files from PageMaker or 
most any application. 

The easiest way is to use the PDFWriter, a special-purpose 
printer driver that lets you use the "Print" command to print 
directly to a PDF file. However, using 
the PDFWriter won't always give 

you the best results. The PDF-

Writer is a non-Postscript 
driver, and as such won't pro

duce ideal results with docu
ments from high-end layout pro-
grams, such as PageMaker, that are 

m 
� 

Acrobat™ PDF\o/ri 

designed to produce their own Postscript code. If you use 
the PDFWriter to produce PDF files from PageMaker, you 
may notice color shifts in your documents, your trans
formed graphics may print untransformed, the screen pre
views of EPS files will print instead of the EPS files them
selves, and your PDF files may be inconveniently large 
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PageMaker PC/Mac 

Sharing styles among publications 

If you've ever designed a series of publications that need a consistent graphic identity, you 

probably know it's important to use the same styles throughout those publications. That's 

easy enough to do if you create all the publications from the same template (and just define 

all your styles in that template before you start on the individual publications). But most of us 

update our styles as we work, experimenting with and changing our"draft" styles. Fortunate

ly, there are a couple of ways to share styles among publications after you've begun 

work on them. 

Use the "Copy" command in the "Define styles" dialog box to copy all the styles from 

one publication to your active publication. Select "Define styles ... " from the Type menu and, 

in the"Define styles" dialog box, click on the"Copy" button. PageMaker will display the"Copy 

styles" dialog box, in which you can select the publication whose styles you want to copy into 

your active publication. Click "OK." 

If you use the"Copy" command in the "Define styles" dialog box to copy a PageMaker style 

into a publication that already has a style by that name, the incoming style definition will re

place the definition of the existing style (you'll 

receive the alert pictured at right). In addition, 

if some of the styles in your publication are 

based on a style that's overridden by an in

coming style, some of those styles' attributes

� Copy ouer eHisting styles? 

- [cancel] 

may change too,just as they would if you edited the original style on which they're based. If

you want to prevent incoming styles from overriding or affecting existing styles, name your

styles differently from publication to publication.

Use the Clipboard to copy one or a few styles from one publication to another. To do 

so, open the publication that contains the styles you want to copy elsewhere. Select text that 

contains paragraphs assigned each of the styles you want and copy it to the Clipboard (select 

"Copy"from the Edit menu, or press Ctrl + C in Windows or Command+ C on the Mac).

Open the publication into which you want to copy the styles. Select "Paste"from the Edit 

menu or press Ctrl + V (Windows) or Command + V (Macintosh) to paste the text and copy 

the styles to that publication's Styles palette. If you use this method to copy a PageMaker 

style into a publication that already has a style by that name, the existing style in the active 

publication will not change to the incoming style's definition-and the incoming text 

assigned that style will take on the attributes of your existing style definition. 

Need to copy styles? 
If you've ever desig�ed a series of publications that 
need a consistent graphic identity, you probably know 
it's impo�tant to use th� same styles throughout those 
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To copy the styles used in 

the text pictured ot left, we 

selected those text blocks 

with the pointer tool, copied 

them to the Clipboard, then 

switched to another pub

lication. After posting the 

text into the other pub

lication, those styles ap

peared in its Styles palette. 
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micro tip 

(larger than the PageMaker publication files from which 

they were created). 

Despite these limitations, using the PDFWriter may be a 

good option if you want to quickly make a PDF file from a 

simple publication, if your PDF file will be viewed primarily 

on screen, or if your publication doesn't contain EPS files. 

Here's how to use the PDFWriter. 

1. Select the Acrobat PDFWriter driver. In Windows, you can 

set that right in PageMaker-select "Acrobat PDFWriter" 

from the "Print to" drop-down menu in the "Print docu

ment" dialog box. On the Macintosh, select "Acrobat 

PDFWriter" in the Chooser. 

2. Print your document as you normally would. 

3. Enter a name for your PDF file when the Acrobat PDF

Writer prompts you to. We recommend keeping the 

filename to eight characters or less and adding a ".PDF"

extension to the end of the filename-that ensures your

PDF file will be easy to identify and 

open on any platform (Macintosh, 

If you create a PDF from PageMaker 

using the PDFWriter and your pages end 

up in reverse order, print your pub

lication to PDF again after selecting the 

"Reverse order" option in PageMaker's 

"Print document" dialog box. 

Windows, DOS, or UNIX). 

Another way to create a PDF file 

from PageMaker is to print to a 

Postscript file, then process that 

file through the Acrobat Distiller. 

Using this method gives you more 

control over how your graphics 

will look and print in the PDF file, 

and, in many cases, will also give 

you higher-quality results (especially if your document con

tains EPS files). Also, if your publication contains high-reso

lution bitmap images that you want to downsample for on

screen viewing or relatively low resolution printing, you 

should use the Distiller. 

To use the Distiller to create a PDF file from a PageMaker 

publication, follow these steps: 

1. When your publication is ready to convert to PDF, save it 

and select "Print . . .  " from PageMaker's File menu. 

2. In PageMaker's "Print document" dialog box, make sure 

you're set to print to the right device. If you're using 

PageMaker for Windows, change your "Print to" printer to 

"Acrobat Distiller on \DISTASST.PS" (you can also select 

another Postscript printer driver, but if you do, you must 

select the "Write Postscript to file" option in step 4). If 

you're working on the Macintosh, make sure you've se

lected the "LaserWriter 8.1.1" or "PSPrinter 8.1.1" (or 

later) driver in the Chooser. 

3. Select the Acrobat Distiller PPD from the "Type" pop-up 

menu in the "Print document" dialog box. If you're using 

PageMaker for Windows and the "Acrobat Distiller" PPD 

isn't available on this menu, you probably need to 

change its location on your hard disk. When you install 

the Distiller in Windows, it puts the Acrobat Distiller PPD 

(ACRODIST.PPD) in the ACRODIST\XTRAS directory. How

ever, PageMaker won't see it there, so make a copy of that 

file and put it in the ALDUS\USENGLSH\PPD4 directory. 

4. Make sure your publication will print to a Postscript file. 

the "Print to" drop-down menu. This will make your pub

lication print to a Postscript file called DISTASST.PS, 

which will be located in your root directory. If you run the 

Acrobat Distiller Assistant, it will automatically distill this 

file for you. (The Distiller Assistant is available only on the 

PC; for more information, see its documentation.) 

The second way in Windows-and the only way on 

the Macintosh-that you can make PageMaker print your 

publication to a Postscript file is by selecting "Write Post

Script to file" in the "Options" print dialog box and enter

ing a name for your file in the adjacent text field. 

5. In the "Postscript" section of PageMaker's "Options" 

print dialog box, make sure the "Normal" option (not 

"EPS" or "For separations") is selected. 
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6. If you'll be distilling your Postscript file 

on the same computer on which you 

created it, or from some other com

puter that will have all the fonts you've 

used in your document installed, you 

can deselect the "Include download-

able fonts" option in PageMaker's 

"Options" print dialog box. Leaving 

that option selected would make your 

Postscript file unnecessarily large-if 

When you create a 

Postscript file that 

you're going to process 

through the Acrobat 

Distiller, make sure 

you double-check 

the settings In Page

Maker's uoptions" 

print dialog box /see 

steps 4-7 for mare 

information). 

those fonts are installed when you process the file 

through the Distiller, it will be able to obtain all the font 

information it needs from your operating system. 

7. If you're printing a file that contains bitmap graphics, we 

recommend you select the "Normal" (instead of "Opti-

mized") graphics option. 

8. Select any other printing options you want, and press 

"Save" (or "Print" if you're in Windows and did not select 

the "Write Postscript to file" option). PageMaker will print 

your document to a Postscript file. 

9. Once you've created your Postscript file, you're ready to 

process it through the Distiller. (If you're in Windows and

you're using the Distiller Assistant, you won't need to per

form this step-Distiller Assistant will do it for you.) Refer 

to the Distiller documentation for information on how to 

control font embedding and graphic compression. 

PC/Mac 

On the PC, there are two ways to do this. One way is to se- Q I'm getting an error that says I have exceeded the 

lect the "Acrobat Distiller C:\DISTASST.PS" device from number of concurrent users permitted for this copy of 
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PageMaker, but I know my copy is legal. 

What's wrong? 

A If you receive this error message, either too 

many people on your network are using a 

single copy of PageMaker, or you might be run

ning into a symptom of outdated Novell 

NetWare drivers. 

Typically the error you're receiving occurs 

when more people are trying to run PageMaker 

than the license for that copy of PageMaker 

permits. PageMaker 5.0 uses Network Copy De

tection (NCD) to record the number of people 

on the network who are using each copy of 

PageMaker-if that number exceeds the num

ber permitted by the license, the user who 

most recently launched PageMaker will receive 

the error message, and will then have to close 

PageMaker (PageMaker lets you save your work 

before it closes). 

micro tip 

If you run into NCO errors because more 

users are running the same copy of 

PageMaker than is permitted by that 

license, you can use the "WIN BUMPS" 

utility (located in the ALDUS\US

ENGLSH\UTILITY directory) to increase 

the number of users permitted to run 

that copy of PageMaker. But first you'll 

need to buy enough copies of Page

Maker or PageMaker licenses to cover 

that increase, and you'll need to get a 

password from Adobe Customer Service. 

See FaxYI document 3154 04, "Running 

PageMaker 5.0 WINBUMPS Utility ... " 

for more information. 

If your company has purchased enough cop

ies (or licenses) for all its PageMaker users and 

you're receiving this error message, it could be 

that the disk set used to install PageMaker on 

your computer was used to install PageMaker 

on too many other computers. (Someone in 

your company may have installed PageMaker 

from your disk set, mistakenly believing that 

entering a unique serial number during their 

installation would prevent NCD errors. How

ever, it won't-NCD doesn't look at serial num

bers, but at a unique network ID number em

bedded in each copy of PageMaker.) 

To see your network ID number, select 

"About PageMaker ... " from the Help menu 

(Windows) or Apple menu (Macintosh)-it'II be 
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the number listed below your serial number. Following it is 

another number that indicates how many users are licensed 

to run that copy of PageMaker concurrently. When you re

ceive an NCD error, make a note of that ID number and 

check with your colleagues to 

Q&APageMaker 

gin autoflowing. PageMaker will add pages as necessary 

until your entire story is flowed. If you want PageMaker to 

stop, press the spacebar. 

For more information on PageMaker's "Autoflow" feature 

and how to use it, see pages 246-4 7 in the Aldus PageMaker 

toms mac 
02-1010-001001001 

see who else has that ID and is 5.0 User Manual. 

MPM5009369307105 
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2101856 bytts fret 
Sy stem version 7 .50 

therefore running your copy 

of PageMaker. 

If you receive NCD errors 

when you and your colleag

ues are not exceeding the 

number of concurrent users 

permitted by your PageMaker 

license, and you're running the Windows version of Page

Maker 5.0, your problem might be il symptom of outdated 

Novell NetWare VLM drivers. 

Check the date of your NETWARE.DRV file in the 

WINDOW5\SYSTEM directory. If it's 11/24/93 or later, you 

should be using VLM drivers instead of IPX and NETX drivers. 

When PageMaker's NCD component queries the network 

for the name of the server and you're using a version of 

NetWare prior to 4.02 with the 11/24/93 NETWARE.DRV 

driver and the version 1.1 VLM drivers, the server returns the 

wrong information to PageMaker, causing it to report an 

NCD error. 

If you're having this problem, update your NETWARE.DRV 

file to the version dated 9/22/94 or later and get the VLM 

drivers version 1.2 0 or later. These files can be found on 

Novell's forum on CompuServe. Type GO NOVFILES and 

download the WINUP9.TXT and DOSUP9.TXT files, which ex

plain what other files you must download and what you 

should do with them to fix your network problems. If you 

don't have access to CompuServe, your local Novell reseller 

may be able to supply you with the files, or you can obtain 

them directly from Novell by calling (80 0) NETWARE. 

PC Mac 

QI have"Autoflow"turned on, but when I'm typing 
in PageMaker and get to the end of a column, my text 
doesn't automatically flow into the next column. 
What's wrong? 

A Nothing's wrong. PageMaker's "Autoflow" feature just 

isn't designed to affect text you enter manually in Page

Maker. To use the "Autoflow" feature, you must be flowing 

text from a loaded text icon. If you have a story in Page

Maker that you'd like to autoflow, but it isn't in a loaded text 

icon, try this: 

1. Make sure "Autoflow" is selected (it should have a check 

next to it at the bottom of the Layout menu). 

2. Use the pointer tool to select the last text block in the 

story you want to autoflow. 

3. Click on your story's bottom windowshade handle and 

roll it up until all your text disappears. 

4. Click on the bottom windowshade handle's red arrow. A 

loaded text icon will appear. 

5. Click the loaded text icon where you want the text to be-

Q I've been having printing problems ever since I 
installed QuickDraw GX and the LaserWriter GX driver. 
Aren't they compatible with PageMaker? 

A No, QuickDraw GX and the LaserWriter GX driver aren't 

entirely compatible with PageMaker. Unfortunately, in the 

last issue of Adobe Magazine (March/April 199 5), the "So 

What Is GX, Anyway?" article incorrectly stated that the 

LaserWriter GX driver works "just fine" with PageMaker 5.0. 

If you print from PageMaker using the LaserWriter GX 

driver, extra blank pages may print and some PICT graphics 

may not print at all from some publications. Also, the 

LaserWriter GX driver is incompatible with the current ver

sion (1.7) of the "Update PPD" Addition and utility. If you try 

to use Update PPD with this driver, you'll receive the error 

message, "Update PPD vl .7 will not run with QuickDraw GX 

enabled. Please disable it to run Update PPD." In addition, 

when Desktop Printing is disabled, Background Printing is 

enabled and the option to disable Background Printing is 

unavailable in the Chooser. If you remove the PrintMonitor 

from the System Folder, you'll receive the error, "Nothing 

can be printed now, because PrintMonitor could not be 

found. To print, put PrintMonitor into the Extensions folder 

in the System Folder." 

If you encounter these problems you have a few options: 

t You can restore standard printing for all your applica

tions by removing QuickDraw GX files, restoring Type 1 

fonts, and setting up a Postscript printer. 

t You can disable the "QuickDraw GX" and "PrinterShare 

GX" Extensions, restore Type 1 fonts, and set up a Post

Script printer. 

t You can restore standard Postscript printing for Page

Maker 5.0 while retaining QuickDraw GX's Desktop 

Printing for other applications. 

For more information on the LaserWriter GX driver and 

PageMaker, or for instructions on how to restore standard 

Macintosh printing for some or all of your applications, see 

FaxYI document 21 5135, "Unable to Print from PageMaker 

5.0 After Installing QuickDraw GX ... " 

By the way-the PageMaker printing problems related to 

the LaserWriter GX driver need not prevent you from install

ing System 7.5. As of early March, there is only one known, 

confirmed problem between PageMaker 5.0 and one of Sys

tem 7.5's components. The "Macintosh Easy Open" Control 

Panel, which is installed with System 7.5 by default, can in

terfere with some PageMaker 5.0 filters (this problem is not 

difficult to resolve). For more information on this problem, 

see Fax YI document 21 5604, "Error, ' The document named 

[filename] was not ... "' t 
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